Link

_Engine Management 4

G4 PLUG-IN ECU

SUBARU RS LEGACY
SUBARU V1 WRX/STi
SUBARU V2 WRX/STi

INSTALLATION MANUAL

Board Version V1.0 - 4 July 2008

By Link ElectroSystems Ltd.






NOTICE

Due to frequent upgrades, PCLink is not distributed with
new Link ECU's.

PCLink is available for free download at the following
web site:

www.LinkECU.com

Should internet download not be practical, a copy of the
latest version of PCLink on CD can be requested from
your nearest Link Dealer.
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INTRODUCTION

Thank you for purchasing your Link ElectroSystems Ltd. Plug-In
Engine Control Unit (ECU). Link G4 ECU's are an advanced,
fully programmable microprocessor controlled Engine
Management System.

The G4 software platform boasts an impressive list of features
giving a new level of user adjustment. This flexibility allows the
tuner to have complete control over the engine management
system. G4 software employs high resolution fuel and ignition
tables with configurable load and RPM centers. When coupled
with up to six dimensional fuel and ignition mapping, barometric
pressure compensation and intake air temperature correction this
gives an unprecedented level of tuning accuracy. All G4 ECU's
are in field upgradeable, there is no need to return the unit for
software updates.

All Link G4 Plug-In Engine Management Systems are designed
with flexibility and ease of installation in mind. Link Plug-In
systems are deigned to replace the circuit board inside the
factory ECU enclosure. This provides an invisible install that
requires no modification to vehicle wiring and ECU mounting.

Link Engine Management Systems are designed with the final
result in mind. Not only do they boast an impressive range of
performance features, but are designed with a focus on safety,
reliability and drive-ability. However, the ultimate success of your
engine management upgrade is determined by how well the
system is installed and tuned.

Installing and tuning any aftermarket engine management system
is not to be taken lightly. G4 ECU's give the tuner the control &
flexibility that only top after-market engine management systems
in the world can provide. While every effort has been made to
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keep G4 ECU's as user friendly as possible, it should be
recognised that added features bring added complexity.

The complete setup of your ECU can be divided into two
important tasks.

1.

This manual covers the installation of your G4 ECU. While
it is not strictly essential that this work is performed by an
automotive electrician, the knowledge and tools available
to these professionals makes it highly recommended.
Regardless of who does the installation, it is of utmost
importance that instructions provided in this manual are
followed exactly throughout the installation.

Once the G4 ECU has been installed it will need to be
tuned using a laptop computer with PCLink software.
Information on the configuration and tuning of the G4 ECU
is detailed in the online help section of PCLink. G4 ECU's
are shipped pre-loaded with a base configuration that
should be close enough to get most engines running after
a few application specific adjustments have been made.
While hearing the engine running on the new ECU for the
first time is always a satisfying feeling, it is important to
realise that the job is not complete. The amount of tuning
performed and the experience of the tuner are the two
most important factors in determining how happy you will
be with your engine management system.

Should any issues arise during installation, the following options
exist for technical support:

1.

2.
3.

Contact your nearest Link dealer. A Link dealer list is
available on our website.

Link website: www.LinkECU.com

Technical Support Email: tech@LinkECU.com
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4. Online Discussion Board: Available from the Link website.

The majority of questions received by the technical support team
are clearly answered in the manuals. To speed up your
technical inquiry please consult the manuals to make sure that
your question has not already been answered.

SAFETY FIRST

Your Link Plug-In ECU is designed to enhance the performance
of your vehicle. However in all cases, your vehicle must be
operated in a safe manner. Do not tune your vehicle while
operating it on public roads. Obey road rules at all times.

Failure to follow all installation
and operating instructions may
result in damage to the Link
ECU, personal injury, or harm
to property.

DISCLAIMER

All care has been taken to ensure the pin outs and
interconnections of the ECU to the vehicles wiring harness are
correct. However due to variations between vehicle models it is
the installers responsibility to check wiring connections BEFORE
installing the ECU. Link ElectroSystems Ltd. will not be held
responsible for any damage caused by the incorrect installation
of this product.
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PRE-INSTALLATION

Before installing the ECU into the vehicle some pre-installation
checks must be performed.

INJECTOR IMPEDANCE

The Subaru V1-2 G4 Plug-In ECU is NOT designed
to be used directly with low impedance injectors.

All models this ECU is designed for are fitted with high
impedance injectors from factory. This ECU has been designed
to be used with HIGH impedance (greater than 6 Ohms)
injectors. Ballast resistors must be wired if low impedance
injectors are to be used. This means that the ECU is plug-in
compatible with factory fitted injectors combinations on all
models. However if fitting low impedance injectors then ballast
resistors must be wired. Contact your nearest Link dealer to
purchase a ballast resistor pack if required.
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INSTALLATION

The following sections describe physical installation of the ECU
and required sensors. It is recommended that your Link ECU is
installed and tuned by a professional. This will ensure you get
the most out of your Link ECU and minimise the possibility of
damage to the ECU or vehicle. G4 ECU's are sophisticated high
end system and require significant knowledge of engine
management to tune.

ECU HANDLING PROCEDURES

WARNING

The following installation process will require
handling of both the Link ECU and factory ECU.
Both of these are highly sensitive to electrostatic
discharge and are easily damaged. Follow the
anti-static precautions given in this manual
carefully to avoid damaging electronic

components. Warranty claims for ECU's
damaged by electrostatic discharge will NOT be
accepted.
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ANTI-STATIC HANDLING GUIDELINES

Your body builds up an electrical charge as you move around.
This charge can reach very high voltages. Whenever given the
opportunity this energy will attempt to discharge (usually
through your finger tips!). This can be fatal to most electronic
components. Most people have experienced an electrostatic
discharge when they step out of their car or touch a metal
bench top.

The following guidelines describe precautions that can be
taken to reduce the possibility of damaging your ECU:

1. Work only on a conductive surface. A clean steel bench
is suitable.

2. Always wear a wrist strap that is electrically connected
to the conductive working surface.

3. Touch the working surface regularly.
4. Do NOT touch components on the circuit board.

5. Where possible, only handle the ECU by its plastic
header.

6. Do NOT carry the ECU around without static packaging.
7. Do NOT touch the bare terminals in the ECU header.

Observing the above procedures will minimise the chance of
damaging the ECU. Note that failure due to static damage
often does not appear until well after it was caused.
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FITTING THE ECU

The following steps outline the installation procedure:

1.

6.

Remove the factory ECU from the vehicle: Ensure
the key is in the OFF position. The factory ECU
is located under a steel cover on the passengers
side floor (below the passengers feet). Lift the
carpet, remove the cover panel. Unplug the wiring
harness from the factory ECU. Remove the 6mm
bolts (10mm socket) that retain the ECU and
remove the ECU from the vehicle. DO NOT touch
the exposed pins in the factory ECU connector.

Remove the factory ECU's circuit board from its
enclosure: Ensure you are following the given anti-
static guidelines and ARE WEARING A
CONDUCTIVE WRIST STRAP connected to a
conductive working surface. Remove the top and
cover from the ECU enclosure by removing the side
retaining screws. Remove the circuit board by
removing the retaining screws. Hold it only by the
plastic header and place it aside.

Fit the Link Plug-In ECU: Remove the ECU from its
packaging and place it immediately in the factory
enclosure. Place the factory ECU in the packaging
your Link ECU came in for its protection.

If the ECU's USB tuning cable is to be left
permanently connected, a slot will need to be cut in
the top cover. The best place to do this is usually
beside the factory header.

Reassemble the enclosure and fit the ECU back to
the vehicle.

Connect the ECU to the factory wiring loom.
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7. Do NOT attempt to start the vehicle. Proceed to
read through the remaining sections of this manual
first.
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FITTING ADDITIONAL SENSORS

G4 Plug-In ECU's offer various options for the installation of
additional sensors and devices. As a minimum it is
recommended that all ECU's are installed with a Manifold
Absolute Pressure (MAP) sensor and Intake Air Temperature
(IAT) sensor. These parts can be purchased if required from
your nearest Link dealer. Additional details on wiring of various
sensors can be found in any

MAP SENSOR

It is important that the pressure source for a MAP sensor be
taken from a stable pressure source after the throttle body. It is
common to 'T" into the fuel pressure regulators pressure signal.
Do NOT share this signal with other devices such as boost
gauges or blow off valves.

The Link G4 Subaru V1-2 Plug-In ECU supports several options
for fitting of a MAP sensor. Any one of the following options can
be used:

1. Factory MAP Sensor — From factory, all models
supported by this ECU are fitted with a factory MAP
sensor. This sensor is rated to 1.2 Bar of boost (approx
17.5 psi). The factory MAP sensor is wired to An Volt 1.

2. Factory MAP Sensor Upgrade — The factory MAP sensor
can be upgraded by simply replacing the factory MAP
sensor. Contact your nearest Link dealer for upgrade
options.

3. MAP Through Expansion Connector - The expansion
connector provides power ground and analog channels for
the connection of a MAP sensor.

Make sure that the correct An Volt channel has been selected as
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MAP sensor in PCLink and a MAP calibration has been
performed before attempting to start the vehicle.

IAT SENSOR

It is highly recommended that an IAT sensor be fitted in all
applications to provide an input for correction of fuel and ignition
based on the engines air charge temperature.

An IAT sensor should be fitted in the intake system in a location
that accurately represents intake temperature. The most
common location is just prior to the throttle body. Installing in the
manifold is not recommended due to heat soak issues. A fast
response sensor must be used in all forced induction
applications.

From factory, models supported by the Link G4 Subaru V1-2
Plug-In ECU are not fitted with an IAT sensor. No suitable wiring
is run into the engine bay therefore the ECU is designed to have
an IAT sensor wired to the Expansion Connector.

EXPANSION CONNECTOR

The expansion connector is provided to allow easy connection of
additional ECU inputs. No additional outputs are provided on the
expansion connector.

The following expansion connector outputs are provided:

O e Gnd — Sensor Ground Only
) and e +5V Out — Supply for MAP sensor
+5V e DI5/ DI6 — Digital Input for switching
® o S signal
@[Dis e An Volt 5/ An Volt 6 — Analog 0-5V
: :Ix":: g input for external MAP sensor or other
® szp 2 analog signal such as wideband O2 or a
® gTemp 3 boost control knob.
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e An Temp 2/ An Temp 3 — Temperature channel for
additional thermistor temp sensor (such as IAT sensor).
Wire sensor between this pin and Gnd pin.

Important points when wiring to the expansion connector:
e Use only the supplied expansion loom.

e Do not overload the +5V Out pin. Although this is
protected against ECU damage the +5V out signal also
provides power for other sensors.

e Do not connect the ground pin to chassis ground.
This could cause ground loops and introduce unnecessary
interference. Use this pin only to ground external sensors
that are isolated from chassis ground.
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PC TUNING

Although Link ECU's come with base settings that allow the
engine to be started, ALL aftermarket ECU's must be
professionally tuned immediately after installation. Failing to
have the ECU correctly tuned for your vehicle could result in
engine damage or violation of emissions laws.

Link ECU's are tuned using a windows based PC/laptop running
PCLink.

Due to frequent upgrades PCLink is not distributed with new
ECU's. PCLink Can be downloaded free of charge from:

www.LinkECU.com

Should download of PCLink be impractical an installation CD can
be purchased at minimal charge from your nearest Link dealer.

INSTALLING USB DRIVERS

WARNING I
The G4 ECU has on board USB.

BEFORE connecting the ECU to your laptop,
the USB drivers must be installed. Failure to
install the drivers on your laptop first may
result in windows assigning incorrect drivers.
These drivers will not work with the G4 ECU
and are difficult to uninstall.

Before connecting the ECU to your laptop or PC, the ECU USB
drivers must be installed. These drivers are installed as part of
PCLink installation as described in the following section.

Link G4 Subaru V1-2 Plug-In ECU Installation Manual © Link ElectroSystems Ltd. 2008 Page 14


http://www.LinkECU.com/
http://www.LinkECU.com/

INSTALLING PCLINK

INSTALLING FROM THE WEB

Go to the Link website and navigate to the downloads and
software updates section.

1.

3.

4.

Download the latest version of PCLink. When prompted to
run or save the file, select save. It is recommended to
save this file on the desktop.

Double click the saved file and follow on screen
instructions.

When prompted to install USB drivers, select yes. This
may take some time.

When installed, open PCLink by double clicking on the
icon that has been placed on the desktop.

INSTALLING FROM A CD
Insert the PCLink CD into you computer's CD ROM.

1.
2.
3.

Open 'My Computer'
Double click your CD drive.

Double click the file labelled PCLinkSetup.exe (or similar
name).

Follow the on screen instructions.

When prompted to install USB drivers, select yes. This
may take some time.

When installed, open PCLink by double clicking on the
icon that has been placed on the desktop.
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COMMUNICATING WITH THE ECU

PCLink must be installed on a Windows based laptop/notebook
before any adjustments or tuning can be performed. The latest
version of PCLink will be required to tune your ECU and is freely
available for download from:

www.LinkECU.com

Link G4 ECU's have on board USB support. PCLink Installation
will also install the required USB driver software. You MUST do
a complete install of PCLink before connecting the ECU to
the PC for the first time.

After PCLink installation, you will be able to connect to the Link
ECU to the laptop to perform setup and tuning work.

1. Connect the ECU to your laptop using a Link G4 ECU
USB Cabile. If not supplied with the ECU, these can be
purchased from a Link dealer. No other adapter or cabling
is required. Connect the cable to the connector labelled
USB (sometimes marked with an orange O'ring)

2. If this is the first time you have connect a G4 USB ECU to
you laptop follow the driver installation instructions that
appear. When prompted if you want to install drivers
select 'Continue Anyway'.

3. Start PCLink by double clicking on the PCLink icon on the
windows desktop.

4. Switch the key to the ON position. This will provide power
to the ECU.

5. In PCLink, under the 'Options' menu, select 'Connection'.
The connection options dialogue will open. Select the
correct COM Port number from the drop down list or select
Auto for automatic com port detection.
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6. PCLink offers both mouse and keyboard control. To
establish a connection between the PC and ECU using the
mouse, click the ‘L’ icon located near the top centre of the
PCLink screen. Alternatively, press F3. The same
process can be used to disconnect. If a successful
connection is established, PCLink will download settings
from the ECU, otherwise you will be warned that an error
has occurred.

7. Make sure the connection shows “ONLINE” in the top right
corner of PCLink. The logo should also be spinning in the
top right corner.

8. To permanently STORE any changes made to the ECU
click on the 'S' icon near the top centre of the screen or
press F4. If this is not done before turning the ECU's
power off all changes made will be lost.

If connection can not be established, contact one of the support
options given at the beginning of this manual.

Help on individual tuning functions is available through the
PCLink on line help (Press F1, or right click on any item and
select 'What's This?').
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INITIAL ADJUSTMENTS

It is important that the procedures described in the following
sections are performed before any attempt to start the engine is
made.

BASE CONFIGURATION

All G4 Plug-In ECU's are shipped with base configuration
settings. Note that these are provided to reduce initial setup and
tuning times. They are NOT recommended tuning values.
PCLink includes base configurations for various models.
Download the appropriate base configuration into your ECU with
PCLink by connecting to the ECU (described in the Connecting
To PCLink section of this manual), then selecting 'Open' under
the 'File' menu. Select the appropriate .pcl file and then select
'Open'. Downloading large configuration files can take up to a
few minutes. Be patient and acknowledge any messages PCLink
shows.

MAP SENSOR CALIBRATION

The following procedure must be performed before tuning to
ensure that the MAP Sensor is correctly calibrated. This is done
by calibrating the MAP sensor to the ECU's internal Barometric
Absolute Pressure (BAP) sensor. The BAP sensor is calibrated
before the ECU is shipped. To calibrate the MAP sensor:

1. Connect a laptop/notebook PC to the ECU and connect to
the ECU using PCLink.

2. Under the Analog Channels menu, select the An Volt
channel that has been wired to the MAP sensor. Select
the correct MAP Sensor Type.

3. Under the 'Options' menu, select 'MAP sensor calibration'.

4. Follow the on screen instructions.

5. Select the 'Analog Inputs' tab in the runtime values section
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6.

7.

of PCLink (lower part of the screen).

Compare the MAP and BAP values and ensure they have
a similar reading (within 1 kPa).

Perform a 'Store' by clicking on the S button (top center of
screen) or press F4.

TPS CALIBRATION

The Throttle Position Sensor (TPS) is used by the ECU to
calculate various engine management parameters used by
functions such as idle speed control,acceleration enrichment and
motorsport features. It is important that the ECU knows when the
throttle is open and closed (or part way in between). The
following procedure calibrates the ECU to match the TPS:

1.

2.

ok w

8.

Connect a laptop/notebook PC to the ECU and connect to
the ECU using PCLink.

Under the Analog Channels menu, ensure that An Volt 3 is
set to "TPS (Main)'.

Under the 'Options' menu, select 'TPS calibration'.

Follow the on screen instructions.

Select the 'Analog Inputs' tab in the runtime values section
of PCLink (lower part of the screen).

Ensure the Throttle Position value reads 0% when the
throttle is closed and 100% when fully open.

Perform a 'Store' by clicking on the S button (top centre of
screen) or press F4.

|AT SENSOR SELECTION

This section only applies when an Intake Air Temperature (IAT)
sensor has been wired and fitted to the intake system. It is
important that the ECU is calibrated to match the sensor installed
in the engine. This procedure is as simple as selecting the
correct sensor type as follows:

1.

Connect a laptop/notebook PC to the ECU and connect to
the ECU using PCLink.
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Click on 'Analogue Channel' in the configuration tree
Select the An Temp channel the sensor has been wired to.
Ensure that channel (and only that channel) is set to 'Inlet
Air Temperature'.

5. Select the correct "'Temp Sensor Type'.

6. Select the 'Analog Inputs' tab in the runtime values section
of PCLink (lower part of the screen).

Ensure that IAT reads the correct temperature.

Perform a 'Store' by clicking on the S button (top centre of
screen) or press F4.

INPUT AND OUTPUT SETUP

BN

® N

As the Link G4 Subaru V1-2 Plug-In ECU is designed to run
several models there are a few items that must be setup to make
the ECU specific to your model. This is due to the same ECU
header pin being used for different functions between models.

Appendix A in the back of this manual gives a list of the functions
of each channel based on vehicle model.

It is the tuners responsibility to make sure that the following
channels are setup up correctly for the vehicle model the ECU is
fitted to:

e All Auxiliary Output Channels — Use the 'Test On' and
"Test PWM' (at 10 Hz) functions to test the wiring of
channels.

e Auxiliary Output — Fuel Channels 5 and 6 - Use the 'Test
On' and 'Test PWM' (at 10 Hz) functions to test the wiring
of channels.

e All Digital Inputs — Look at the Digital Inputs runtime
values (lower section of the PCLink screen) to confirm
each channels operation.

e All Analog Volt Inputs — Look at the Analog Inputs runtime
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values (lower section of the PCLink screen) to confirm
each channels operation.

e All Temperature Inputs — Look at the Analog Inputs
runtime values (lower section of the PCLink screen) to
confirm each channels operation.
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PRE-STARTUP

After performing all steps discussed in previous sections of this
manual, you should be ready to start the engine. This section
discusses steps required to run the engine. It is the tuners
responsibility to ensure the engine mechanically ready to run and
that no safety hazards exist.

Should the engine not start, do not crank the motor over
endlessly. Stop and diagnose the problem or seek professional
help.

For further help on any of the settings discussed in the
following sections, consult the online Help in PCLink. Online help
can be invoked by pressing F1, or right clicking any item and
selecting ‘What'’s this?’.

PRE-START SETUP

To avoid potential engine damage and wasted time, the
adjustments presented in the following sections must be made
before attempting to start the engine.

1. Ensure the ECU and all associated components are
connected and correctly wired/installed.

2. Fully charge the vehicle’s battery, as the engine will be
required to be cranked during the setup procedure.

3. Check all oil and water levels are correct.

TRIGGER CALIBRATION

Trigger Calibration is the process of calibrating the ECU to
actual engine position. This procedure is required for all
applications to ensure actual ignition timing is exactly as
expected.
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1. Connect the ECU to PCLink.
2. Select 'Fuel', then 'Fuel Setup':

a. Set ‘Injection Mode’ to OFF. This will prevent
the engine from trying to start while the triggers
are calibrated.

b. Perform a Store (press F4) to make sure fuelling
is not re-enabled if power to the ECU is lost.

3. Click on ‘Triggers’ then ‘Calibrate Triggers’.

4. Perform the correct trigger calibration procedure as
described in the PCLink online help (Press F1).

5. Set the 'Injection Mode' back to 'Sequential' and
perform a Store by pressing F4.

Note that trigger calibration must be performed again once the
engine is running. Due to the acceleration and deceleration of
the crankshaft at low speeds, an inaccurate measurement of
engine timing is usually made. Also it is often harder to see
timing marks with a timing light at slow engine speeds. Trigger
calibration should be checked again at between 2000-4000 RPM
where engine speed is stable and a more consistent timing
reading can be obtained.
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FIRST TIME STARTUP

After performing steps described in previous sections of this
manual you should now have the ECU in a state where the
engine is ready to run.

This section describes important tuning adjustments that should
be made once the engine is running.

ESSENTIAL TUNING ADJUSTMENTS

MASTER

Master is the ECU's overall fuel trim number or “coarse
adjustment” it is important that this number is correct to prevent
the numbers in the main fuel table running out of range. This
setting also provides a fast way to enrich or lean the engine over
the entire range.

Master is found in the Fuel->Fuel Setup menu and should be set
so that the numbers in the middle of the fuel table end up around
a value of 50. This is to allow sufficient span of the numbers in
the main fuel table. A typical value for Master is between 10 to
15 ms.

INJECTOR VOLTAGE (DEAD TIME) CORRECTION

There is always a delay between the injector being energised and
the injector actually opening. Likewise, there is a small delay
between the injector being de-energised and the injector closing.
The opening time is considerably longer than the closing time,
however the overall result is that less fuel will flow for a given
pulse width than would be expected with an 'ideal injector’. To
compensate for this the injector pulse widths are increased to
compensate for this 'dead-time'. The dead-time for a given
injector is a function of the battery voltage, differential fuel
pressure and the type of injector driver (saturated or peak and
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hold). A typical dead-time at 3 Bar differential fuel pressure and
14 volts is just under 1ms (ms = millisecond = 1 thousandth of a
second).

The injector dead-time table allows the dead- time for different
battery voltages to be entered. The values represent the dead-
time in milliseconds. These should increase with falling system
voltage.

A professional tuner will know how to correctly set injector dead
time. Itis essential that this value is correct to ensure stable fuel
mixture over the entire battery voltage range.

NOTE: any change to the fuel pressure or injectors will require a
recalibration of the injector dead-times.
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APPENDIX A — PIN FUNCTIONS

| Subaru V1-2 WRX/STi, RS Legacy

Auxiliary Outputs

Aux 1 ISC Close (ISC Slave)
Aux 2 ISC Open (ISC Solenoid)
Aux 3 Tacho

Aux 4 Wastegate Solenoid
Aux 5 Fuel Pump Relay

Aux 6 A/C Out

Aux 7 Purge Solenoid

Aux 8 CE Light

Aux - Injection Outputs

Inj 5 Fan Relay 2

Inj 6 Fan Relay 1

Analog Channels

An Volt 1 Factory MAP Sensor
An Volt 2 AFM Signal

An Volt 3 TPS (Main)

An Volt 4 Oxygen Sensor Signal
An Volt 5 Expansion Connector
An Volt 6 Expansion Connector
An Temp 1 ECT

An Temp 2 Expansion Connector
An Temp 3 Expansion Connector
Digital Inputs

DI 1 Start Signal

DI 2 A/C In

DI 3 Ignition Switch

Dl 4 Vehicle Speed

DI 5 Power Steer Switch
DI 6 Power Steer Switch
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APPENDIX B — PINOUT

—

| m—

1

[1T2]s]4]s]e]~

8 [ 9 [10]11]12]13] [31]32]33]34

[14]15]16]17[18]19]20]21]22[23]24]25] 26 [39]40[41]42

35|36|37|38| |51|52|53
43|44|45|46] |57]58|59

—
54]55]s6] [71]72]73]74]75]76]77]78]79]B0]81]

60]61]62] [82[83]84[85]86]87[s8]89]90[01]92]

Pin ECU Function Pin ECU Function
1 Injector 1 75 An Temp 1
2 Injector 2 76 An Volt 4
3 Injector 3 78 An Volt 1
4 Ignition 1
5 Ignition 3
6 Ignition 2
7 Ignition 4
8 Aux 7
10 Aux — Inj 5
11 Aux 4 Other Connections
12 Aux 2
13 Aux 1 Expansion 1 | Signal Ground
14 Injector 4 Expansion 2 | +5V Out
17 Aux 5 Expansion 3 |DI 5
18 Aux 6 Expansion 4 | DI 6
21 Aux 8 Expansion 5 | An Volt 5
23 Aux — Inj 6 Expansion 6 [An Volt 6
39 Aux 3 Expansion 7 |An Temp 2
45 DI 1 Expansion 8 |An Temp 3
46 DI 2
55 An Volt 3
57 DI 3
58 Dl 4
73 An Volt 2
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APPENDIX C — KNOWN ISSUES

Current known issues with the Link G4 Subaru V1-2 Plug-In
ECU:

e There are currently no known issues.
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APPENDIX D — WARRANTY

Link ElectroSystems Ltd. Warranty Statement
Effective 5pm, April 5, 1992

All products manufactured or distributed by Link ElectroSystems Ltd. Are
subject to the following, and only the following, LIMITED EXPRESS
WARRANTIES, and no others

For a period of one (1) year from and after the date of purchase of a new Link
ElectroSystems Ltd. Product, Link ElectroSystems Ltd. Warranties and
guarantees only to the original purchaser / user that such a product shall be
free from defects of materials and workmanship in the manufacturing process.
A product claimed to be defective must be returned to the place of purchase.
Link ElectroSystems Ltd., at its sole option, shall replace the defective product
with a comparable new product or repair the defective product. This
expressive warranty shall be inapplicable to any product not properly installed
and properly used by the purchaser — user or to any product damaged or
impaired by external forces. This is to the extent of warranties available on
this product. Link ElectroSystems Ltd. Shall have no liability whatsoever for
consequential damages following from the use of any defective product or by
reason of the failure of any product. Link ElectroSystems Ltd. Specifically
disclaims and disavows all other warranties, express or implied including,
without limitation, all warranties of fithess for a particular purpose (except for
those which apply to product or part thereof that is used or bought for use
primarily for personal, family or household purposes), warranties of
description, warranties of merchantability, trade usage or warranties of trade
usage.

Link ElectroSystems Ltd. License Agreement

The programme in this system is licensed not sold. Link ElectroSystems Ltd.
Grants you a license for the programme only in the country where you
acquired the programme. You obtain no rights other than those granted under
this license. Under this license you may use the programme on only one
machine at a time. If you transfer the programme you must transfer a copy of
this license and all other documentation. Your license is then terminated. You
may terminate your license at any time. Link ElectroSystems Ltd. May
terminate your license if you fail to comply with the terms and conditions of this
license. In either event you must destroy your copy of the programme.
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